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Raven's Synergy Action Rules Manager product is a flexible package for building custom applications 
for the Raven M4x Blade. Action Rules puts the power of the event-driven M4x Blade into the hands 
of the user, allowing anyone to create, save, and run custom M4x Blade applications. Raven's Synergy 
Action Rules Manager software application provides the platform to build custom Action Rules 
applications. 
An Action Rule Set is a collection of Action Rules, executed in the same order that they're created. 
Many Action Rules can be combined to perform a specific function on the M4x Blade. After creating 
an Action Rules Set, the Action Rules Set can be flashed to the Blade (the Action Rule Set is activated 
after the next Blade reset). 
A single Action Rule is a combination of "events," "conditions," and "actions". An event can occur on 
the Blade itself, or on any one of the M4x modules attached to the Blade. A condition is a state that 
can be optionally checked before performing some action. Finally, an action is ultimately the function 
that is performed by the Blade (or module) based on the event and optional condition(s). 
 
When creating an Action Rule, think about what you want the Raven M4x Blade to do in terms of a 
given event. Also, think about where that event will be occurring—on the Blade, or on one of the 
modules. For instance, one of the most basic events that occurs is the "Blade Start-up" event. This 
event occurs directly after the Blade is powered on or reset, and allows the user to perform any pre-
configuration that might be required before the other Action Rules go into effect. Such pre-
configuration might include: 

· setting a variable to a known value 
· starting a timer 
· enabling a tone on a given port 
· setting up bridging between ports 

Other examples of events are: 
· a tone went active on port 1 
· a tone went inactive on port 1 
· COR went active on port 3 
·  

After selecting an event to act upon, "conditions" can be selected to further qualify any action that 
might be taken. For instance, if an event occurs, we might want to set PTT on port 1—but maybe only 
if, say, the port 4 COR is active. A condition lets us check whether or not COR is active on port 4. 
Further, multiple conditions can be selected for a single Action Rule; in that case, the conditions are 
logically ANDed together when the Blade is deciding whether or not to perform an action. 
 
Finally, after the event and optional conditions are set up, the "action" to perform is selected. Just like 
an event, the action may be taken upon the Blade, or upon any one of the modules in the Blade. An 
"action" might be: 

· start a timer 
· set PTT on a port 
· send a tone out a port 
· send a DTMF string out a port 
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· mute the receive side of a port 
· bridge from one port to another port 

Also, several actions can be selected to be performed; you're not limited to just one action per event. 
 

 
Getting Started 

 

Launch the Synergy software from the desktop shortcut or from the start menu.  When the software launches, your 

screen should look like the one below.  Before continuing, it is recommended that you close and disconnect from the 

M4x user application software, as having the Blade connected to both at the same time can cause conflicts.    

 

 
 

http://www.ravencomm.com/


 

www.ravencomm.com 4655 Longley Lane, Reno, NV  89502 775-858-2400 

TN100 Rev. A January 2013 © 2013 Raven Electronics Corporation Page 3 of 46   

TECHNICAL NOTES 
 

TECHNICAL NOTES 

TN133 Synergy Action Rules Guide  
 
 

M4x 

Before beginning to write your rule set, it is a good idea to outline what it is you want your rule set to accomplish.  Base 

your outline on events, conditions (if any), and the actions you want taken as result of your events and conditions.  

Individual rules are based on Resources and Events.  Resources include the items in the list below: 

 Blade Startup.  Rules associated with Blade startup are executed when the Blade is powered on, reset, or after a 

power cycle. 

 Blade Variables.  Variables are used to track the status of other events and execute rules based on the status of 

a variable or when a variable state changes.  They can also be used as a Condition requiring a variable to be in a 

particular state before the rule is executed.    

 Blade Timers.  Timers are used to execute a rule following the expiration of the timer, or the state of a timer can 

be named as a Condition before executing a rule.   

 Individual Module Types.  Individual module resources are used to name Conditions and write rules associated 

with specific modules and ports installed in the Blade.   

 

Event types vary depending on the resource selected.  The events associated with the resources are listed below: 

 

 Blade Startup.  On Start is the only event associated with Blade Startup.  It simply is the rule set that will execute 

when the Blade is first powered on.  It is not always necessary to create a startup event; the need for a startup 

event depends on your specific application and requirements.    

 Blade Variables.  Variable changed is the only event associated with Blade Variables.   

 Blade Timers.  Timer expired is the only event associated with Blade Timers. 

 Individual Module Types.  See screen shot below for a list of event types associated with a module.  
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To begin, click on the “Add” button in the lower right of the startup screen shown above.  You will see a screen like the 

one on the next page. At the top in the box labeled “Description” type the name of the event, any conditions, and 

associated action(s).  For example, this might be, “Blade Startup, mute port 1 Input.” Note that this is a start up 

condition and the rule will execute whenever the Blade is started such as following a power cycle.  It is not necessary to 

have a startup action; instead, you can have a rule associated with an event that occurs after start up.    
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After you have named your rule, select the resource from the drop down menu in the upper left for which resource your 

rule will apply.  Resources, as described previously, include Blade Start Up, Blade Variables, Blade Timers, and choices for 

individual modules that might be installed in your Blade.   

 

Once you have selected your resource, select your event type from the drop down menu in the upper center.  

Remember, your event choices will be different depending on the resource you choose. 

 

If applicable, select any condition(s) which must be met before the action(s) associated with this rule will be executed.  

Select a condition(s), if any, by clicking on the Add button in the Condition area.  Next, you must select a resource 

associated with your condition.  The drop down Resource menu is available to the left as shown in the diagram below. 

Note that the choices of conditions are different depending on which resource you select.  You can specify as many 
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conditions as you want to be met before the action(s) associated with the event will be executed.  Note that for 

multiple conditions, all conditions must be met or else the action(s) will not be executed. 

 

 

 

 

 

Click here to pull down this menu. 

 

 
 

To specify your Action, click on the Add button in the Actions section.  You will then see the screen shot on the next 

page.  
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After the Actions section appears, you must select an action and an associated resource.   See screen shot below for a 

menu of available actions.  Note that these actions are associated with the Blade Resource as shown in the screen 

shot.  If you don’t see the Action you require, you might have to choose the resource first in order to find the action 

you require.  Depending on the type of action you choose, the choice of associated resources will vary. Likewise, the 

type of resource you choose will determine which actions are available with that resource. 
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A sample rule is shown on the following page.  The resource is a module installed in the Blade.  The event is COR/E-Lead 

went active on port 1.  The condition is COR is inactive on port 2 and the action is mute port 1 output.  For this rule to 

execute the action of muting the output of port 1, both the event must take place and condition met before the action 

executes.   
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The above rule is just an example and would require another rule to un-mute the port.  

 

Rule sets can consist of as few as two rules to many rules.  The following pages show a rule set consisting of two rules 

and one consisting of eighteen rules.  The 2-Rule set while very simple, solved a customer’s problem of cross 

connecting a conventional radio with a trunked radio.   

 

The 18-Rule set provided a solution to a customer for a priority audio bridge.  Ports were arranged in a hierarchy with 

the highest priority ports overriding lower priority ports for access to the transmitter.    
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Port Selection 

 

In some of the above examples, a specific port was designated as either the port on which an event will take place, or a 

port on which an action will take place. The modules included in the Blade are dual modules meaning each has two 

ports.  The location of the module in the blade, will define its external port number. A Blade can be configured with up 

to eight ports.  These ports are pinned or wired out to connectors on the front panel and labeled 1-8.  To designate a 

port in a Synergy rule, you cannot use the port number labeled on the front panel.  Instead you must name the module 

number and that module’s port number. Referring to the screen shot on the following page, port selection is designated 

by specifying the module and that module’s port number.  In the screen shot the event and the action are both assigned 

to module 1, port 1.  This is port 1 on the front of the blade.  For port 2, the designation would be module 1, port 2.  

Other ports are assigned similarly as show on the following page.  You can only specify ports for those ports for which 
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your Blade is configured.  For example, if your Blade is configured for six ports, then you cannot specify rules for ports 7 

& 8.   

Port 3: Module 2, Port 1 

Port 4: Module 2, Port 2 

Port 5: Module 3, Port 1 

Port 6: Module 3, Port 2 

Port 7: Module 4, Port 1 

Port 8: Module 4, Port 2   
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Blade-Timers 

 

A Blade-Timer is a useful tool for an action, condition, or event in your rule set.  Examples of these include: 

 

As an action:  Timers are usually started or stopped upon some kind of event.  For example, you start timer 1 for 500 MS 

upon detection of a COR input on port 1.   

 

As a condition:  The expiration or the state of a timer (active or inactive) may be stipulated as a condition in addition to 

the event, before an action is executed.  For example, your event is function tone detected on port 1 and your action is 

mute port 1 receive.  In addition to the event you could stipulate that timer 1 be inactive before the muting takes place.   

 

As an event:  A timer event is when a timer expires. The expiration of the timer might trigger an action or be a condition 

before another action executes.  For example in, you set timer 1 for 500 MS when a COR input was detected on port 1.  

Upon expiration of this timer (the event) you then assert a PTT output on port 2.  In this example, the timer was used to 

delay the PTT output by 500 MS. 

 

When setting timers, you might have more than one timer.  Timers are numbered beginning with timer 1.  You have up 

to 255 timers to work with.  The screen shot below shows timer 1 expired as an event, timer 2 inactive as a condition, 

and time 3 set for 1 second as an action.  Timers are set in 5 MS intervals so a value of 200 is entered for a timer of one 

second.   
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Blade-Variables 

 

A Blade-Variable is a useful tool for an action, condition, or event in your rule set.  Variables are used to keep track of 

the state of different activities going on in your application.  Examples of these include: 

As an action:  When an event occurs, you create a variable related action.  For example, a variable might normally have a 

state of 0.  For example, 2175 Hz low level guard tone is detected on port 2.  In response to this event, you could create 
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an action that changes the state of a variable.  Changes to variables include setting from one value to another, adding, 

subtracting, multiplying, and dividing. There are also options for AND and OR functions on a variable.    

 

As a condition:  As with our timer example in the previous section, a variable state can be set as a condition before any 

action associated with an event is executed.   

 

As an event:  You can set as an event, a variable changing state.  Associated with this event, you can then create an 

action, with conditions if desired, in response to this variable state change. For example, variable # 3 changes state.  In 

response, you could assert PTT on port 2 or any other action.    

 

The screen shot below shows an example of a variable as an event (Variable 1), a condition (Variable 2), and an action 

(Variable 3).  As with timers, you have up to 255 variables (1-255) to work with. 
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Raw Commands 

 

Some customers occasionally have applications that require raw commands.  Raw commands are custom commands 

that perform actions not available in the standard offering found in the software.  If you have an application for which 

you cannot find the appropriate actions, please contact Raven for support.  It is possible your application can be fulfilled 

using Raw commands.   

 

 
Contact Raven Tech Support for assistance with Raw Commands 
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Other Applications 

Depending on the complexity of your application, in some cases it might be better to contact Raven technical support 

and discuss a custom application.  The screen shot below shows a custom application done for Motorola.  This 

application involved dozens of different DTMF codes and hundreds of actions associated with the different codes.  This 

was not an application suited for Synergy Actions rules as it would have made for an extremely long and complicated 

rule set.  Motorola worked with Raven engineering to set up the custom application shown below.   
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Saving Rule sets 

 

It is recommended that you regularly save your rules set as you work on it.  To save, select the File menu and then Save.  

See screen shot below. You will be prompted to save your file.  Change the default directory and file name if you like 

before saving.   
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Opening Rule sets 

 

Occasionally, you will need to open a saved rule set to finish an in-progress rule set, make changes to a rule set, or to 

install a rule set on a Blade.  To open a rule set select the File menu and then select Open File.  See screen shot below.  

You will then be prompted to find the file you saved.  Just double click it or select it and select Open.  Your rule set will 

then load and display.   
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Software version and caution about loading rules set made on prior version 

 

To confirm the version of software you are using, select the Help menu as shown in the screen shot below.   

 
 

After selecting the help menu, you will the screen shot as shown below.  The software version is noted in the upper 

right.  Note also that the M4x user app software is also noted.  It is recommended that the version of M4x software be 

the same as that noted with the version of Synergy.  For example, in the screen shot below, M4x version 4.0.4.4 is noted 

along with version 1.0.0.3 of Synergy software. Using a different version can occasionally cause incorrect rules sets to 

display.  This is generally never a problem as the Synergy software and M4x software are installed on the same software 

disk received with your shipment.  This problem usually occurs if you receive a rule set from a colleague or associate 

who made their rule set on a different version.   
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Editing/Deleting Rules 

Sometimes it is necessary to edit a rule(s) in a rule set.  Open your rule set as described above, find the rule you want to 

edit, and select Edit to the right of the rule.  The rule will expand allowing you access to the Events, resources, 

Conditions and Actions you need to edit. 

 

To delete a rule, click the Delete button.  CAUTION!  When you select delete, you will not be given an Are You Sure 

warning message; the rule will be immediately deleted with no option to undo or save.  Be sure the rule set is saved (if 

you want to preserve it) before selecting the delete command.     
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Click here to edit a rule or here to delete it. 

 

 

 

 

 

 

 

 

 

 

 

Exiting Synergy 
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To exit Synergy, select the File menu and select Exit.  See screen shot below.  After selecting Exit you will see the warning 

message asking if you are sure you want to exit.  CAUTION!  This is not a save prompt and if you select yes, the program 

will close and any unsaved progress will be lost.  If you haven’t saved your work, click Cancel or No and save your file 

before exiting.   
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Clearing Rule sets 

 

If instead of exiting Synergy you want to clear the rule set you are working on, select the M4x Options menu and then 

Clear Action Rules.  Be sure you have saved your rules set first, as the warning prompt is not a save prompt.  Once you 

select Yes, the rule set will clear from the desktop and any unsaved progress will be lost.  If you are currently editing a 

rule, selecting Clear will give you a message saying you are in the middle of editing a rule and you must first finish and 

close the editing window before clearing.  Be sure to save, if desired, after you finished editing.  Once the rule set is 

cleared from the desk top, you can load another rule set or begin on a new rule set. 
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Configure M4x settings before writing your rules set to the Blade 
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Before writing your rules to the Blade, it is sometimes necessary to configure your Blade first using the M4x software.  

While many of the functions and configurations available in the M4x software can be performed using Synergy, it is 

generally simpler and faster to make these configurations using the M4x software.  For example, you can configure a 

bridge using Synergy, but in almost all cases this should be done using the M4x software as it is a much simpler and 

faster process using the M4x software.  There might be some cases where you would want to bridge in Synergy.  

Examples might include a conditional bridge that only bridges based upon the events and conditions outlined in your 

rule set.   

 

Other reasons to use the M4x software are for individual port settings such as LED status, gain settings, audio delays, 

etc.  If you are unsure whether to use Synergy or M4x software, contact Raven tech support for assistance.  

 

Writing a rules set to the Blade 

 

When you are satisfied with the rule set you have written it is time to write the rule set to your Blade.  To write the rules 

to the Blade, be sure the USB cable is connected from your computer to the Blade.  Next, select the M4x Options Menu 

as shown in the screen shot below and select Write Rules to Blade.  As mentioned previously, do not have the M4x User 

software open when writing rules to the Blade, as this can cause conflicts.   
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After you select the Write Rules to Blade command, you should see a compiler screen like the one in screen shot above.  

Be sure you see the Saving Runtime, Runtime saved, and M4x Connection Closed messages at the bottom of the 

compiler message. If you are working with the restricted license version of Synergy, you will see the Blade not license 

message in the compiler screen as shown above.  This can be ignored if your rule set consists of four or fewer rules.   

 

Testing Rule sets—Test incrementally as rule set is made. 

 

As a general strategy, Raven recommends rule sets be tested incrementally.  This makes trouble shooting a simpler 

process in isolating where in your rule set a problem might be located.  If you have simple rule sets consisting of 2-4 

rules, then incremental testing might not be necessary, but for larger rule sets it is helpful to test incrementally.  There 

are a few ways to test incrementally.  One is to build the rule set incrementally and test it after each rule is added.  

Another way is to build it completely and then test it by disabling rules.  In the screen shot below is a rule set consisting 

of eighteen rules.  To incrementally test this rule set, you could disable all the rules by unchecking boxes in the far right 

column titled Enabled. This disables the rule without deleting it.  In this example you might want to disable all rules 

except the first one and then test the first rule under the startup condition.  Once you are satisfied your rule is working 

stand alone, then you can enable more of the rules and test again.  Keep in mind that some rules might need to be 

enabled for another rule to function properly.  For example, if you had a rule that set a timer upon a certain event and 

another rule that only executed upon expiration of that timer, you would need to enable both rules in order to test.  In 

this example, in addition to enabling both rules, you would need to create the event and conditions (if any) that started 

the timer.   
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Limited rule set 

Every Blade comes with a limited Synergy license installed.  The license allows you to create rules sets up to a maximum 

of four rules.  There are many applications that can be accomplished in four or fewer rules.  More complex applications 

require the unrestricted Synergy license.  Contact Raven sales if you need to purchase the unrestricted license. 
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Unlocking the full Synergy license 

 

Skip this section if you purchased your Blade with an unrestricted license.  If you are upgrading to a full license, you will 

need to provide Raven with your Blade ID number.  To obtain your Blade ID number, open and connect the Blade to the 

M4x user software.  You can see the Blade ID number 00:04:A3:50:1F:3E in the System Components section on the right 

of the screen. Your ID number will be different than the one shown below. 

Blade ID number 

 
 

After you have given the ID number to Raven and purchased the license key, you will be sent a code key via email.  To 

unlock the license open the Synergy software and select the M4x Options menu and then Add License.   
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After selecting Add License you will the screen shot below.  In the blank space, enter the license key.  It is best to copy & 

paste the license key from the email you received as it is a very long key code, see second screen shot.   
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After you enter the license key and select Add, you should see this message. You can click close.  Your Blade now has the 

full unrestricted license on it. 

 

 

Rule limits for Mini-Blades 

If you purchase a Raven Mini-Blade with an unrestricted license, there is still a limit to the number of rules you can 

write.  This is not a limitation of the license; rather, it is limitation of the available memory in which the rules are saved.  

There is no set limit on the number of rules, as it depends on not only the number of rules but the complexity of rules 

and how many actions, variables, timers, and conditions the rules have.  You should expect to be able to write up to ten 

rules in a Mini-Blade provided the rules are not overly complex with many conditions and actions for each rule in the 

rule set.  A Mini-Blade includes a maximum of two 4-wire ports, so due to its low port density, rule sets will tend to be 

small anyway.  

 

Note also that early generation Blades (up to eight ports capacity) have the same memory as the Mini-Blades and are 

subject to this same rule limitation as the Mini-Blade.  Since there are more possible ports, use of the early generation 

Blades might tax the rule set limit.  Since approximately 2012, all Blades, except the Mini-Blade, supplied by Raven are of 

the latest generation and include an expanded memory capacity so the maximum number of rules is greatly increased.  

If you are unsure if you have an early generation Blade or a current generation Blade, contact Raven Tech Support for 

assistance.   
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Creating DTMF Driven Ruleset 

A DTMF driven action is an action in response to a DTMF code received on a specified M4x Blade port or ports.  The 

action can be anything from the list of actions available for the type of module being used.  For example, an action can 

be a relay closure, sending of a tone, muting or unmuting a port(s), enabling an audio path or bridge between or 

amongst ports, and so on.     

DTMF tone detection is enabled on a port-by-port basis in the M4x software.  Instructions on how to enable DTMF tone 

detection are covered later.   

When beginning your ruleset, it is a good idea to begin with an On Start event.  This is simply a rule that executes when 

the unit is initially powered on or is reset in software.  For a DTMF driven ruleset, Raven suggests you clear the DTMF 

buffer in your On Start rule.  Whenever you add a new rule, it starts off as an On Start event.  From there in the Actions 

area, change the resource to the type of module you are using.  This will almost always be a 476-150/151 or 476-

150/151/153.  When done and under Action, find Clear DTMF Buffer and select it.  To finish, select the port for which 

you want to clear its DTMF buffer.  In the screen shot below, you can see the DTMF Buffer is being cleared for port 1 on 

start.  If you wanted to clear other ports, just add a like action for the other ports.  Clearing the DTMF buffer is important 

as the status of the buffer is used to decode and act upon the DTMF code you have chosen to execute your chosen 

actions.  
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The following steps will guide you through a sample ruleset for when a DTMF code of 1223 is detected on port 1, a relay 

closure is activated for one (1) second on port 2.  This is an actual ruleset in use by a Raven customer.   

Rule 2 is shown below.  The event is DTMF Digit Went Off on port 1.  We are stipulating a condition that the digit 

detected was a *.  The action in response is to clear the DTMF buffer.  This rule is used to clear the buffer manually in 

case an error in dialing was made.  The * key condition is so as to not clear the buffer for any other digit dialed.  Instead 

of a * digit, any other digit can be used such as the # key for clearing the buffer.  This customer uses the * key as part of 

their dialing plan, so before dialing the 1223 code, they begin with the * key to clear the buffer, so the code dialed is 

*1223.   
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Rule 3 is also a DTMF Digit Went Off event only this time, we are not specifying a condition and for the action we are 

setting and resetting a timer any time a DTMF digit goes off.  This timer, if it ever expires, will reset the DTMF buffer.  

This is done in case a user begins dialing, changes their mind and doesn’t clear the DTMF buffer with the * key.  The 

timer duration can be changed in 5-ms intervals.  Below it is set for 800 intervals of 5 seconds or four seconds total.   
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Rule 4 is the rule that executes the action of clearing the DTMF buffer for when timer 2 expires.  Timer 2 was set in in 

rule 3.    
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Rule 5 is another DTMF Digit Went Off rule.  This time instead of using it to clear the buffer or set a timer, we are adding 

the digit to the DTMF buffer.  As stated earlier, the status of the buffer will determine if and when the action associated 

with the DTMF code will be executed. In order for any action to be executed for a DTMF code, that code must be in the 

buffer before the action will be executed.  
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Rule 6 is another DTMF Digit Went Off event only this time, there are two conditions and two actions associated with 

the event.  In the screen shot below the two conditions are number of DTMF digits in the buffer and the DTMF code 

detected.  If both conditions are met, and only if both are met, the two actions will be executed.  The actions are Set M-

Lead on port 2 and Set Timer.  This is a different timer than the timer set in rule 3.  This second timer, when it expires, is 

used to release the M-Lead on port 2 and also clear the DTMF buffer.  
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Rule 7 is the final rule and it executes upon expiration of the timer set in rule 6.  It releases the M-Lead and resets the 

DTMF buffer.   
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Setting DTMF Detection on a Port 

A port must be set for DTMF detection before it can detect DTMF tones being received.  To set a port for DTMF 

detection, connect the M4x Blade to the M4x User App software.  Be sure the Synergy software is closed and off the 

desktop when you start the M4x software.  Next, select the port(s) on which DTMF detection is required.  In the above 

example port 1 is the port which requires DTMF detection.  The screen shot below shows the port 1 DTMF menu.  You 

will need to check the box in the center left area for Enable DTMF Detector.  When done, click on the Save button in the 

lower right.     

 

 

Check this box to enable DTMF Detection. 
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